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10GBASE-T Electrical Conformance Test Application — At A Glance
10GBASE-T Electrical
The Agilent U7236A 10GBASE- T Electrical Conformance Test Application 
helps you verify the transmitter device under test (DUT) conforms to the 
specifications with the Agilent Infiniium digital storage oscilloscopes. The 
10GBASE- T Electrical Conformance Test Application:

• Lets you select individual or multiple tests to run.

• Lets you identify the device being tested and its configuration.

• Shows you how to make oscilloscope, spectrum analyzer and vector 
network analyzer connections to the device under test.

• Automatically checks for proper oscilloscope configuration.

• Automatically sets up the oscilloscope for each test.

• Provides detailed information for each test that has been run and lets 
you specify the thresholds at which marginal or critical warnings 
appear.

• Creates a printable HTML report of the tests that have been run.
NOTE The tests performed by the 10GBASE-T Electrical Conformance Test Application are 
intended to provide a quick check of the electrical health of the DUT. This testing is not a 
replacement for an exhaustive test validation plan.
 
Compliance testing measurements are described in the IEEE 802.3- 2006 
Standard. For more information, see the IEEE 802 Standards web site at 
www.ieee802.org.

Required Equipment and Software

In order to run the 10GBASE- T Electrical Conformance Test Application, 
you need the following equipment and software:

• U7236A 10GBASE- T Electrical Conformance Test Application software.

• 80000 or 90000 Series Infiniium Digital Storage Oscilloscope (DSO). 
Agilent recommends using 2 GHz and higher bandwidth oscilloscope.

Refer to the test application release notes for the required version of 
Infiniium oscilloscope software.

• Agilent also recommends using a second monitor to view the automated 
test application.

• Spectrum Analyzer with the minimum frequency range upper limit of 
3 GHz (MXA, EXA, PSA or ESA series).

• Vector Network Analyzer with usable frequency range of 1 MHz to 
500 MHz (875x, 439x, E506x/7x and N5230A series).

• Balun with 3 GHz bandwidth.

• U7237A 10GBASE- T Transmitter test fixture.
 Conformance Testing Methods of Implementation 3
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• SMA cable (24” or shorter).

• SMP to SMA cables (provided with U7237A 10GBASE- T Transmitter test 
fixture).

• Keyboard, quantity = 1 (provided with Agilent Infiniium oscilloscope).

• Mouse, quantity = 1 (provided with Agilent Infiniium oscilloscope).

Below is the required license: 

• U7236A 10GBASE- T Electrical Conformance Test Application license.

• Memory Upgrade Option 001 is recommended for the 80000 Series 
oscilloscopes for best performance.
10GBASE-T Electrical Conformance Testing Methods of Implementation



In This Book
 

10GBASE-T Electrical
This manual describes the tests that are performed by the 10GBASE- T 
Electrical Conformance Test Application in more detail; it contains 
information from (and refers to) the IEEE 802.3- 2006 Standard and it 
describes how the tests are performed.

• Chapter 1, “Installing the 10GBASE- T Electrical Conformance Test 
Application” shows how to install and license the automated test 
application software (if it was purchased separately).

• Chapter 2, “Preparing to Take Measurements” shows how to start the 
10GBASE- T Electrical Conformance Test Application and gives a brief 
overview of the required preparation and how the application is used.

• Chapter 3, “U7237A 10GBASE- T Transmitter Test Fixtures” describes 
the U7237A 10GBASE- T transmitter test fixture in detail.

• Chapter 4, “Transmitter Timing Jitter (MASTER) Test” contains 
information on the transmitter timing jitter MASTER test as specified in 
clause 55.5.3.3 of the IEEE 802.3- 2006 Standard.

• Chapter 5, “Transmit Clock Frequency Test” contains information on 
the transmit clock frequency test as specified in clause 55.5.3.5 of the 
IEEE 802.3- 2006 Standard.

• Chapter 6, “Maximum Output Droop Test” contains information on the 
positive and negative droop test as specified in clause 55.5.3.1 of the 
IEEE 802.3- 2006 Standard.

• Chapter 7, “Transmitter Power Spectral Density Test” contains 
information on the power spectral density test as specified in clause 
55.5.3.4 of the IEEE 802.3- 2006 Standard.

• Chapter 8, “Power Level Test” contains information on the power level 
test as specified in clause 55.5.3.4 of the IEEE 802.3- 2006 Standard.

• Chapter 9, “Transmitter Linearity Tests” contains information on the 
transmitter linearity tests as specified in clause 55.5.3.2 of the IEEE 
802.3- 2006 Standard.

• Chapter 10, “MDI Return Loss Test” contains information on the MDI 
return loss test as specified in clause 55.8.2.1 of the IEEE 802.3- 2006 
Standard.

• Chapter 11, “Transmitter Timing Jitter (SLAVE) Test” contains 
information on the transmitter timing jitter SLAVE test as specified in 
clause 55.5.3.3 of the IEEE 802.3- 2006 Standard.

• Appendix I, “Calibrating the 80000 and 90000 Series Infiniium 
Oscilloscopes” describes how to calibrate the oscilloscope in preparation 
for running the 10GBASE- T automated tests.

See Also

• The 10GBASE- T Electrical Conformance Test Application’s online help, 
which describes:
 Conformance Testing Methods of Implementation 5
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• Creating or opening a test project.

• Setting up tests.

• Selecting tests.

• Configuring selected tests.

• Connecting the oscilloscope to the DUT.

• Running tests.

• Viewing test results.

• Viewing/printing the HTML test report.

• Saving test projects.
10GBASE-T Electrical Conformance Testing Methods of Implementation
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U7236A 10GBASE-T Electrical Conformance Test Application
Methods of Implementation
1
Installing the 10GBASE-T Electrical 
Conformance Test Application

Installing the Software    11

Installing the License Key    11

If you purchased the U7236A 10GBASE- T Electrical Conformance Test 
Application separately, you need to install the software and license key.
Installing the Software
 

1 Make sure you have the required version of the Infiniium oscilloscope 
software.

• Refer to the test application release notes for the required version of 
Infiniium oscilloscope software.

• On the oscilloscope, you can check the current version of software 
by choosing Help>About Infiniium... from the main menu.

2 To obtain the 10GBASE- T Electrical Conformance Test Application, go 
to Agilent website: http://www.agilent.com/find/scope- apps- sw.

The link for 10GBASE- T Electrical Conformance Test Application will 
appear. Double- click on it and follow the instructions to download and 
install the application software.
Installing the License Key
1 Request a license code from Agilent by following the instructions on the 
Entitlement Certificate.

You will need the oscillocope’s “Option ID Number”, which you can find 
in the Help>About Infiniium... dialog.

2 After you receive your license code from Agilent, choose 
Utilities>Install Option License....

3 In the Install Option License dialog, enter your license code and click 
Install License.
11Agilent Technologies
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1 Installing the 10GBASE-T Electrical Conformance Test Application
 

4 Click OK in the dialog that tells you to restart the Infiniium 
oscilloscope application software to complete the license installation.

5 Click Close to close the Install Option License dialog.

6 Choose File>Exit.

7 Restart the Infiniium oscilloscope application software to complete the 
license installation.
10GBASE-T Electrical Conformance Testing Methods of Implementation



 

U7236A 10GBASE-T Electrical Conformance Test Application
Methods of Implementation
2
Preparing to Take Measurements

Calibrating the Oscilloscope    14

Starting the 10GBASE-T Electrical Conformance Test Application    15

Before running the 10GBASE- T Electrical Conformance Test Application 
automated tests, you should calibrate the oscilloscope. Once the 
oscilloscope has been calibrated, you are ready to start the 10GBASE- T 
Electrical Conformance Test Application and perform the measurements.
13Agilent Technologies
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Calibrating the Oscilloscope
14
If you haven’t already calibrated the oscilloscope, see Appendix I, 
“Calibrating the 80000 and 90000 Series Infiniium Oscilloscopes”.
NOTE If the ambient temperature changes more than 5 degrees Celsius from the calibration 
temperature, internal calibration should be performed again. The delta between the 
calibration temperature and the present operating temperature is shown in the 
Utilities>Calibration menu.

NOTE If you switch cables or probes between channels or other oscilloscopes, it is necessary to 
perform cable and probe calibration again. Agilent recommends that, once calibration is 
performed, you label the cables with the channel for which they were calibrated.
10GBASE-T Electrical Conformance Testing Methods of Implementation



Preparing to Take Measurements 2
Starting the 10GBASE-T Electrical Conformance Test Application
10GBASE-T Electrical

 

1 From the Infiniium oscilloscope’s main menu, choose 
Analyze>Automated Test Apps>10GBase- T Ethernet Test.

Figure 1 The 10GBASE-T Electrical Conformance Test Application
NOTE If 10GBASE-TEthernet does not appear in the Automated Test Apps menu, the 10GBASE-T 
Electrical Conformance Test Application has not been installed (see Chapter 1, “Installing 
the 10GBASE-T Electrical Conformance Test Application”).
 Conformance Testing Methods of Implementation 15
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2 Preparing to Take Measurements
 

Figure 1 shows the 10GBASE- T Electrical Conformance Test Application 
main window. The task flow pane, and the tabs in the main pane, show 
the steps you take in running the automated tests:

Set Up Lets you identify the test environment, including 
information about the device being tested and other 
test instruments that can be automatically configured. 

Select Tests Lets you select the tests you want to run. The tests 
are organized hierarchically so you can select all tests 
in a group. After tests are run, status indicators show 
which tests have passed, failed, or not been run, and 
there are indicators for the test groups.

Configure Lets you configure test parameters.

Connect Shows you how to connect the oscilloscope, spectrum 
analyzer and vector network analyzer to the device 
under test for the tests to be run.

Run Tests Starts the automated tests. If the connections to the 
device under test need to be changed while multiple 
tests are running, the tests pause, show you how to 
change the connection, and wait for you to confirm 
that the connections have been changed before 
continuing.

Results Contains more detailed information about the tests 
that have been run. You can change the thresholds at 
which marginal or critical warnings appear.

HTML Report Shows a compliance test report that can be printed.
10GBASE-T Electrical Conformance Testing Methods of Implementation



Preparing to Take Measurements 2
Online Help Topics
10GBASE-T Electrical

 

For information on using the 10GBASE- T Electrical Conformance Test 
Application, see its online help (which you can access by choosing 
Help>Contents... from the application’s main menu).

The 10GBASE- T Electrical Conformance Test Application’s online help 
describes:

• Starting the 10GBASE- T Electrical Conformance Test Application 

• To view/minimize the task flow pane

• To view/hide the toolbar

• Creating or opening a test project.

• Setting up tests and equipment.

• Selecting tests.

• Configuring selected tests.

• Connecting the oscilloscope to the DUT.

• Running tests.

• Viewing test results.

• To show reference images and flash mask hits.

• To change the display settings.

• To change the remote settings.

• To change margin thresholds and report trial display.

• To change the loading and auto- recovery option. 

• Viewing/Exporting/Printing the HTML test report.

• Saving test projects.
 Conformance Testing Methods of Implementation 17
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U7236A 10GBASE-T Electrical Conformance Test Application
Methods of Implementation
3
U7237A 10GBASE-T Transmitter Test 
Fixtures

U7237A 10GBASE-T Transmitter Test Fixture Description    20

Test Modes    23

Characteristics, Regulatory, and Safety Information    24

The U7237A 10GBASE- T transmitter test fixtures are required to perform 
the 10GBASE- T electrical conformance test measurements.
19Agilent Technologies



3 U7237A 10GBASE-T Transmitter Test Fixtures
 

U7237A 10GBASE-T Transmitter Test Fixture Description
20
The U7237A 10GBASE- T transmitter test fixture is required to perform the 
measurement with the 10GBASE- T Electrical Conformance Test 
Application. The fixture helps you to easily access the 10GBASE- T test 
signals.

The fixture has 3 sections: Section 1, Section 2 and Section 3.

Section 1 of the U7237A 10GBASE- T transmitter test fixture is required 
for the following tests:

• Transmitter timing jitter (MASTER) test

• Transmit clock frequency test

• Maximum output droop test

• Transmitter power spectral density test

• Power level test

• Transmitter linearity tests

• MDI return loss test

Section 2 of the fixture is required for the following test:

• Transmitter timing jitter (SLAVE) test

Section 3 of the fixture is required for calibration during the MDI return 
loss test. 

Figure 2, Figure 3 and Figure 4 shows the U7237A 10GBASE- T 
transmitter test fixtures. The U7237A 10GBASE- T transmitter test fixture 
is shipped to you as one piece of board with 3 sections, as shown in 
Figure 2. The board has a V- cut break- out tab that allows you to easily 
separate the board into two pieces.

Figure 2 Complete U7237A 10GBASE-T Transmitter Test Fixture Board
10GBASE-T Electrical Conformance Testing Methods of Implementation



U7237A 10GBASE-T Transmitter Test Fixtures 3

10GBASE-T Electrical

 

The bigger piece of board, as shown in Figure 3 has Section 1 and Section 
2. This sections are required to perform the conformance tests. Whereas, 
the smaller board which has Section 3, as shown in Figure 4 is required 
to calibrate the Vector Network Analyzer.

Figure 3 Section 1 and Section 2 of the U7237A 10GBASE-T Transmitter Test Fixture

Figure 4 Section 3 of the U7237A 10GBASE-T Transmitter Test Fixture
 Conformance Testing Methods of Implementation 21
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Fixture and Accessories
22
The complete set of 10GBASE- T transmitter test fixture contains the 
following items:

* It is always recommended to mate and de- mate connectors straight up. 
However, this connector is capable of mating at a +/-  .020" radial 
tolerance. In handling this connector, one should not hold or squeeze it on 
the interface side. Always hold it on the knurled end.

Part Number Description Quantity

U7237-66501 10GBASE-T test fixture 1 unit

1250-3553* 50 ohm RF SMP female straight connector 6 units

N4235-61602 16 inches phase matched SMP female/SMA male cable pair 2 units

U7237-61601 8 inches 10GBASE-T shielded patch cord 2 units

0955-2095 Precision instrumentation Balun 300 KHz to 3 GHz 1 unit
Dimension
The dimension of the U7237A test fixture board is as follows:

PCB board height = 1.89 inches

PCB board width = 6.30 inches

PCB board thickness = 0.063 inches
10GBASE-T Electrical Conformance Testing Methods of Implementation



U7237A 10GBASE-T Transmitter Test Fixtures 3
Test Modes
10GBASE-T Electrical

 

The test modes are required for testing the transmitter waveform, 
transmitter distortion, transmitter jitter, transmitter droop and BER 
testing:

• Test Mode 1 is a mode provided to enable the timing jitter testing on a 
SLAVE transmitter.

• Test Mode 2 is for transmitter jitter testing when the transmitter is in 
the MASTER timing mode and for transmit clock frequency testing.

• Test Mode 3 is for transmitter jitter testing in the SLAVE mode if the 
loop timing is supported.

• Test Mode 4 is for the transmitter linearity testing.

• Test Mode 5 is used to verify whether the transmitter is compliant with 
the transmit PSD mask, the power level test and MDI return loss test.

• Test Mode 6 is for testing the transmitter droop.

• Test Mode 7 is used to enable the measurement of the bit error rate of 
the link.
 Conformance Testing Methods of Implementation 23
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Characteristics, Regulatory, and Safety Information

Electrical Characteristics
24
The following electrical characteristics are the specification of the U7237A 
10GBASE- T transmitter test fixture:

Description Specification

Bandwidth 3 GHz

Attenuation between the master & slave 
in Section 2 (3 GHz bandwidth)

15 dB + 1 dB (including transmission line)

Isolation (between transmitter & Pair D) > 30 dB

Insertion loss Frequency Range Max Insertion Loss

0- 500 MHz < 0.5 dB

500 MHz - 1 GHz < 1.5 dB

1 GHz - 2 GHz < 3.2 dB

2 GHz - 3 GHz < 4.5 dB

Ethernet shielded patch cord CAT6A

Balun bandwidth 300 KHz to 3 GHz
Operating and Non-operating Environmental Characteristics
The following are the environmental characteristics of the U7237A 
10GBASE- T transmitter test fixture:

Description Minimum Requirement

Ambient temperature Operating = 0°C to 40°C
Non-operating = - 51°C) to 71°C

Humidity Operating = 95% RH at 40°C for 24 hours

Altitude Operating = 4,570m (15,000 ft)
Non-operating = 15,244m (50,000 ft)

Indoor use This fixture is rated for indoor use only

Random vibration HP/Agilent class B1 and MIL-PRF-2880 OF Class 3 
random

Mechanical shock HP/Agilent class B1 and MIL-PRF-2880 OF (operating 
30g, 1/2 sine, 11-ms duration, 3 shocks/axis along 
major axis. Total of 18 shocks)
10GBASE-T Electrical Conformance Testing Methods of Implementation
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Safety Information
10GBASE-T Electrical

 

The U7237A 10GBASE- T transmitter test fixture herewith complies with 
the essential requirements of the Low Voltage Directive 73/23/EEC and the 
EMC Directive 89/336/EEC, and carries the CE- marking accordingly. The 
product was tested in a typical configuration with HP/Agilent test systems.

The following are the safety regulatory information of the U7237A 
10GBASE- T transmitter test fixture:

Minimum Requirement:

IEC 61010- 1: Second edition 2001- 2

EN 61010- 1:2001

UL3111- 1 or UL 6101B- 1:2003 (must be an Agilent ID)

Canada: CSA- C22.2 No. 1010.1:1992
 Conformance Testing Methods of Implementation 25
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U7236A 10GBASE-T Electrical Conformance Test Application
Methods of Implementation

4 
Transmitter Timing Jitter (MASTER) 
Test

Connection for Transmitter Timing Jitter (MASTER) Test    28

Transmitter Timing Jitter (MASTER) Test - Test Method of 
Implementation    31

This section provides the Methods of Implementation (MOIs) for 
Transmitter Timing Jitter (MASTER) test using an Agilent 80000 or 90000 
Series Infiniium oscilloscope, 10GBASE- T Transmitter test fixture and the 
10GBASE- T Electrical Conformance Test Application.
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4 Transmitter Timing Jitter (MASTER) Test
 

Connection for Transmitter Timing Jitter (MASTER) Test

When performing the Transmitter Timing Jitter (MASTER) test, the 
10GBASE- T Electrical Conformance Test Application will prompt you to 
make proper connections. The connections for the Transmitter Timing 
Jitter (MASTER) test may look similar to the following diagram. Refer to 
the Connection tab in 10GBASE- T Electrical Conformance Test Application 
for more details.

You may connect the SMP to SMA cables to any of the oscilloscope 
channels. You can identify the channels used for each signal in the 
Configuration tab of the 10GBASE- T Electrical Conformance Test 
Application. (The channels shown in Figure 5 is just an example.)

Test Procedure

1 Start the automated test application as described in “Starting the 
10GBASE- T Electrical Conformance Test Application" on page 15.

2 Connect one end of the RJ45 cable to the DUT and another end to J1 
connector on the Section 1 of the 10GBASE- T Transmitter test fixture.

3 Connect the SMP connector pairs, for example A+ and A-  SMP 
connectors to the any two of the oscilloscope channels by using the 
SMP to SMA cables.

Figure 5 Connection for Transmitter Timing Jitter (MASTER) Test
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4 In the 10G Ethernet test application, click the Set Up tab.

5 Under the Connection group, check the connection pair(s) under test. 
You can select more than one pair of connection.

6 Enter your comments in the Comments text box.

7 Click the Select Tests tab and check the tests you want to run. Check 
the parent node or group to check all the available tests within the 
group.

8 Follow the 10GEthernet test application’s task flow to set up the 
configuration options (see Table 1), run the test, and view the test 
results.

Figure 6 Selecting Transmitter Timing Jitter (MASTER) Test
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Table 1 Test Configuration Options

Configuration Option Description

Connection Pair 
(Positive)

The channel number for connection pair positive.

Connection Pair 
(Negative)

The channel number for connection pair negative.
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Transmitter Timing Jitter (MASTER) Test - Test Method of Implementation

The purpose of the Transmitter Timing Jitter (MASTER) test is to verify 
that the MASTER transmitter timing jitter of the device under test (DUT) 
is within the conformance limits specified in clause 55.5.3.3 of IEEE 802.3.

For this test, the obtained timing jitter must be less than or equal to 5.5ps 
over a sample size of 200000 + 20000. This jitter value is to be verified for 
each of the four pairs of the 10G test mode 2 signaling for a particular 
DUT. These pairs are identified as Pair A, Pair B, Pair C and Pair D.

Test Definition Notes from the Specification

Clause 55.5.3.3 Transmitter Timing Jitter

RMS period jitter over an integration time interval of 1 ms + 10% is 
defined as the root mean square period difference from the average period 
(T -  Tavg) accumulated over a sample size of 200000 + 20000.

Pass Condition

The RMS period jitter measured at the MDI must be less than or equal to 
5.5 ps for all the pairs. 

Measurement Algorithm

1 Configure the MASTER DUT to produce test mode 2 signal.

2 Convert the single ended signal to differential signal: 

FUNC2 = Positive Connection Pair (default Channel1) subtract Negative 
Connection Pair (default Channel3) to get the differential signal.

3 Trigger on the rising edge of Positive Connection Pair. Set the trigger 
level to offset voltage of Positive Connection Pair.

4 Set the sampling rate to 20 Gsa/s.

5 Apply a Bandpass filter with 200 MHz center frequency and 2 MHz 
bandwidth.

6 The number of acquisitions to be taken depends on the time range and 
the memory depth selected by the customers:

Number of Acq = Time Range / (Memory Depth * 1/Sampling Rate)

RMS period jitter
T Tavg–( )2[ ]( )

Sample Size
----------------------------------------------=
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4 Transmitter Timing Jitter (MASTER) Test
 

7 Enable the histogram and measure the period to the acquired 
waveform.

8 Take the standard deviation from the histogram statistics.

9 Compare the test result with the compliance test limit.

Test References

See Clause 55.5.3.3 Transmitter Timing Jitter in the IEEE 802.3- 2006 
Standard.
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Transmit Clock Frequency Test

Connection for Transmit Clock Frequency Test    34

Transmit Clock Frequency Test - Test Method of Implementation    36

This section provides the Methods of Implementation (MOIs) for Transmit 
Clock Frequency test using an Agilent 80000 or 90000 Series Infiniium 
oscilloscope, 10GBASE- T Transmitter test fixture and the 10GBASE- T 
Electrical Conformance Test Application.
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Connection for Transmit Clock Frequency Test

When performing the Transmit Clock Frequency test, the 10GBASE- T 
Electrical Conformance Test Application will prompt you to make proper 
connections. The connections for the Transmit Clock Frequency test may 
look similar to the following diagram. Refer to the Connection tab in 
10GBASE- T Electrical Conformance Test Application for more details.

You may connect the SMP to SMA cables to any of the oscilloscope 
channels. You can identify the channels used for each signal in the 
Configuration tab of the 10GBASE- T Electrical Conformance Test 
Application. (The channels shown in Figure 7 is just an example.)

Test Procedure

1 Start the automated test application as described in “Starting the 
10GBASE- T Electrical Conformance Test Application" on page 15.

2 Connect one end of the RJ45 cable to the DUT and another end to J1 
connector on the Section 1 of the 10GBASE- T Transmitter test fixture.

3 Connect the SMP connector pairs, for example A+ and A-  SMP 
connectors to the any two of the oscilloscope channels by using the 
SMP to SMA cables.

4 In the 10G Ethernet test application, click the Set Up tab.

Figure 7 Connection for Transmit Clock Frequency Test
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5 Under the Connection group, check the connection pair(s) under test. 
You can select more than one pair of connection.

6 Enter your comments in the Comments text box.

7 Click the Select Tests tab and check the tests you want to run. Check 
the parent node or group to check all the available tests within the 
group.

8 Follow the 10GEthernet test application’s task flow to set up the 
configuration options (see Table 2), run the test, and view the test 
results.

Table 2 Test Configuration Options

Figure 8 Selecting Transmit Clock Frequency Test

Configuration Option Description

Connection Pair 
(Positive)

The channel number for connection pair positive.

Connection Pair 
(Negative)

The channel number for connection pair negative.
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Transmit Clock Frequency Test - Test Method of Implementation

The purpose of the Transmit Clock Frequency test is to verify that the 
device under test (DUT) meets the requirements as specified in clause 
55.5.3.5 of IEEE 802.3. For this test, the obtained Transmit Clock 
Frequency must be in the range of 800MHz +-  50ppm. This is verified for 
each of the four pairs of the 10G test mode 2 signaling for a particular 
DUT. These pairs are identified as Pair A, Pair B, Pair C and Pair D.

Test Definition Notes from the Specification

Clause 55.5.3.5 Transmit Clock Frequency

The symbol transmission rate on each pair of the MASTER PHY shall be 
within the range 800 MHz + 50ppm.

Pass Condition

The obtained Transmit Clock Frequency must be within 800 MHz + 50ppm.

Measurement Algorithm

1 Configure the DUT to produce test mode 2 signal.

2 Convert the single ended signal to differential signal: 

FUNC2 = Positive Connection Pair (default Channel1) subtract Negative 
Connection Pair (default Channel3) to get the differential signal.

3 Trigger on the rising edge of Positive Connection Pair . Set the trigger 
level to offset voltage of Positive Connection Pair .

4 Set the sampling rate to 20 Gsa/s.

5 Measure the clock data rate of the FUNC2 signal with full auto clock 
recovery.

6 Compare the test result with the compliance test limit.

Test References

See Clause 55.5.3.5 Transmit Clock Frequency in the IEEE 802.3- 2006 
Standard.
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Connection for Maximum Output Droop Test    38

Maximum Output Droop Test - Test Method of Implementation    40

This section provides the Methods of Implementation (MOIs) for Maximum 
Output Droop test using an Agilent 80000 or 90000 Series Infiniium 
oscilloscope, 10GBASE- T Transmitter test fixture and the 10GBASE- T 
Electrical Conformance Test Application.
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Connection for Maximum Output Droop Test

When performing the Maximum Output Droop test, the 10GBASE- T 
Electrical Conformance Test Application will prompt you to make proper 
connections. The connections for the Maximum Output Droop test may 
look similar to the following diagram. Refer to the Connection tab in 
10GBASE- T Electrical Conformance Test Application for more details.

You may connect the SMP to SMA cables to any of the oscilloscope 
channels. You can identify the channels used for each signal in the 
Configuration tab of the 10GBASE- T Electrical Conformance Test 
Application. (The channels shown in Figure 9 is just an example.)

Test Procedure

1 Start the automated test application as described in “Starting the 
10GBASE- T Electrical Conformance Test Application" on page 15.

2 Connect one end of the RJ45 cable to the DUT and another end to J1 
connector on the Section 1 of the 10GBASE- T Transmitter test fixture.

3 Connect the SMP connector pairs, for example A+ and A-  SMP 
connectors to the any two of the oscilloscope channels by using the 
SMP to SMA cables.

4 In the 10G Ethernet test application, click the Set Up tab.

5 Under the Connection group, check the connection pair(s) under test. 
You can select more than one pair of connection.

Figure 9 Connection for Maximum Output Droop Test
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6 Enter your comments in the Comments text box.

7 Click the Select Tests tab and check the tests you want to run. Check 
the parent node or group to check all the available tests within the 
group.

8 Follow the 10GEthernet test application’s task flow to set up the 
configuration options (see Table 3), run the test, and view the test 
results.

Table 3 Test Configuration Options

Figure 10 Selecting Maximum Output Droop Test

Configuration Option Description

Connection Pair 
(Positive)

The channel number for connection pair positive.

Connection Pair 
(Negative)

The channel number for connection pair negative.
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Maximum Output Droop Test - Test Method of Implementation

The purpose of the Maximum Output Droop test is to verify that the 
positive and negative droop of the device under test (DUT) is within the 
conformance limits specified in the clause 55.5.3.1 of IEEE 802.3- 2006. For 
this test, the amplitude of both the positive and negative droop must be 
less than 10%, measured at initial value of 10ns after the zero cross point 
and final value at 90ns after the zero cross point. This droop will be 
verified for each of the four pairs of the 10G test mode 6 signaling for a 
particular DUT. These pairs are identified as Pair A, Pair B, Pair C and 
Pair D.

Test Definition Notes from the Specification

Clause 55.5.3.1 Maximum Output Droop

With the transmitter in test mode 6 and using the transmitter test fixture 
1, the magnitude of both the positive and negative droop shall be less than 
10%, measured with respect to an initial value at 10ns after the zero 
crossing and final value at 90 ns after the zero crossing.

Pass Condition

The average droop over all acquisitions in a given lane must be less than 
10%.

Measurement Algorithm

1 Configure the DUT to produce test mode 6 signal.

2 Convert the single ended signal to differential signal: 

FUNC2 = Positive Connection Pair (default Channel1) subtract Negative 
Connection Pair (default Channel3) to get the differential signal.

3 Trigger on the rising edge of Positive Connection Pair . Set the trigger 
level to offset voltage of Positive Connection Pair .

4 Set the sampling rate to 20 Gsa/s.

5 Measure the amplitude at 10ns reference from the trigger point.

6 Then, measure the amplitude at 90ns reference from the trigger point.

7 Calculate the droop:

%droop = (10ns amplitude) -  (90ns amplitude)/(10ns amplitude)

8 Compare the test result with the compliance test limits.
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Test References

See Clause 55.5.3.1 Maximum Output Droop in the IEEE 802.3- 2006 
Standard.
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7 
Transmitter Power Spectral Density 
Test

Connection for Transmitter Power Spectral Density Test Using an External 
Spectrum Analyzer    44

Connection for Transmitter Power Spectral Density Test Using the 
Oscilloscope    50

Transmitter Power Spectral Density Test - Test Method of 
Implementation    52

This section provides the Methods of Implementation (MOIs) for 
Transmitter Power Spectral Density test using an Agilent 80000 or 90000 
Series Infiniium oscilloscope, spectrum analyzer, 10GBASE- T Transmitter 
test fixture and the 10GBASE- T Electrical Conformance Test Application.

There are two methods of running the Transmitter Power Spectral Density 
test:

• Using an external spectrum analyzer.

• Using the oscilloscope.
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Connection for Transmitter Power Spectral Density Test Using an External 
Spectrum Analyzer

When performing the Transmitter Power Spectral Density test, the 
10GBASE- T Electrical Conformance Test Application will prompt you to 
make proper connections. The connections for the Transmitter Power 
Spectral Density test may look similar to the following diagram. Refer to 
the Connection tab in 10GBASE- T Electrical Conformance Test Application 
for more details.

Test Procedure

1 Start the automated test application as described in “Starting the 
10GBASE- T Electrical Conformance Test Application" on page 15.

2 Connect one end of the RJ45 cable to the DUT and another end to J1 
connector on the Section 1 of the 10GBASE- T Transmitter test fixture.

3 Connect the SMP connector pairs, for example A+ and A-  SMP 
connectors to the balun by using the SMP to SMA cables.

Figure 11 Connection for Transmitter Power Spectral Density Test Using an External 
Spectrum Analyzer
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4 Connect the balun to the spectrum analyzer by using the SMA cable.

5 Use a LAN or GPIB to USB cable to connect the Spectrum Analyzer to 
the oscilloscope. 

6 In the 10G Ethernet test application, click the Set Up tab.

7 Under the Connection group, check the connection pair(s) under test. 
You can select more than one pair of connection.

8 Ensure that the application detects the spectrum analyzer connection to 
the oscilloscope. Else, click on the Connect... button in the Spectrum 
Analyzer External Instruments group. A pop- up box will appear where 
you can enter either the VISA/SICL address or the IP address. Enter 
the information and click the Verify button, followed by the Done 
button to close this box. The VISA/SICL address or the IP address can 
be obtained from the IO Control Connection Expert application, as 
shown in Figure 13.

Figure 12 Setup page and spectrum analyzer pop-up box
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9 Once the application detects the spectrum analyzer, it is indicated on 
the Setup page as shown in Figure 14 below.

Figure 13 Agilent Connection Expert
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10 Enter your comments in the Comments text box.

11 Click the Select Tests tab and check the tests you want to run. Check 
the parent node or group to check all the available tests within the 
group.

Figure 14 Setup page after application has detected the spectrum analyzer
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12 Follow the 10GEthernet test application’s task flow to set up the 
configuration options (see Table 4), run the test, and view the test 
results.

Figure 15 Selecting Power Spectral Density Test
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Table 4 Test Configuration Options

Configuration Option Description

Connection Pair 
(Positive)

The channel number for connection pair positive.

Connection Pair 
(Negative)

The channel number for connection pair negative.

Power Test

Start Frequency The start frequency for the spectrum analyzer.

Stop Frequency The stop frequency for the spectrum analyzer.

Resolution Bandwidth The resolution bandwidth for the spectrum analyzer.

Reference Level The reference level for the spectrum analyzer.

Test Type The test type for the Power Spectral Density test.

Command File The command file for the spectrum analyzer.
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Connection for Transmitter Power Spectral Density Test Using the 
Oscilloscope

When performing the Transmitter Power Spectral Density test, the 
10GBASE- T Electrical Conformance Test Application will prompt you to 
make proper connections. The connections for the Transmitter Power 
Spectral Density test may look similar to the following diagram. Refer to 
the Connection tab in the 10GBASE_T Electrical Conformance Test 
Application for more details.

Test Procedure

1 Start the automated test application as described in “Starting the 
10GBASE- T Electrical Conformance Test Application" on page 15.

2 Connect one end of the RJ45 cable to the DUT and another end to J1 
connector on the Section 1 of the 10GBASE- T Transmitter test fixture.

3 Connect the SMP connector pairs, for example A+ and A-  SMP 
connectors to the oscilloscope.

4 In the 10G Ethernet test application, click the Set Up tab.

5 Under the Connection group. check the connection pair(s) under test. 
You can select more than one pair of connection.

6 Enter your comments in the Comments text box.

Figure 16 Connection for Transmitter Power Spectral Density Test Using the Oscilloscope
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7 Click the Select Tests tab and check the tests you want to run. Check 
the parent node or group to check all the available tests within the 
group.

8 Follow the 10G Ethernet test application's task flow to set up the 
configuration options (see Table 4), run the test, and view the results.
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Transmitter Power Spectral Density Test - Test Method of Implementation

The purpose of the Transmitter Power Density test is to verify that the 
power spectral density (PSD) of the device under test (DUT) is within the 
conformance limits specified in clause 55.5.3.4 of IEEE 802.3.

The PSD of the DUT must be within the upper and lower masks as shown 
in Figure 17 below. PSD of the DUT is verified for each of the four lanes 
of test mode 5 signal. These pairs are identified as Pair A, Pair B, Pair C 
and Pair D.

Test Definition Notes from the Specification

Clause 55.5.3.4 Power Spectral Density

In test mode 5 (normal operation with no power backoff), the transmitted 
power shall be in the range of 3.2 dBm to 5.2 dBm and the power spectral 
density of the transmitter, measured into a 100 Ω, load using the test 
fixture, shall be between the upper and lower masks specified in Equation 
(55- 9) and Equation (55- 10). The masks are shown graphically in 
Figure 17:

Figure 17 PSD vs. Frequency
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Pass Condition

The signal obtained from the test mode 5 must fit within the PSD mask 
shown in Figure 17.

Measurement Algorithm When Using an External Spectrum Analyzer

1 Configure the DUT to produce test mode 5 signal.

2 Set the spectrum analyzer as the following:

• Start frequency = 3 MHz and Stop frequency = 3 GHz

• Resolution bandwidth = 3 MHz

• Averaging (default value is 50)

• Noise marker function

• DC coupling (not applicable for ESA)

3 Collect the data from the spectrum analyzer to the application and plot 
the graph.

4 Set the SA to AC coupling mode.

5 Compare each point of the graph with the upper and lower limits with 
respective to the frequency.
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Measurement Algorithm When Using the Oscilloscope

1 Configure the DUT to produce test mode 5 signal.

2 Trigger and collect the waveform from the oscilloscope.

3 Apply the selected windowing function to the sampled waveform.

4 Compute the power spectra as:

Where N = number of segments or cycles to compute.

5 Apply a correction factor to the signal to compensate windowing losses:

6 Normalize the power spectra to get the power spectral density:

7 Convert the amplitude of the power spectral density from Vp^2 to 
Vrms^2.

8 Compare each point of the result to the upper and lower limits with 
respect to the frequency.

Test References

See Clause 55.5.3.4 Transmitter Power Spectral Density in the IEEE 
802.3- 2006 Standard.
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Connection for Power Level Test Using an External Spectrum Analyzer    56

Connection for Power Level Test Using the Oscilloscope    61

Power Level Test - Test Method of Implementation    63

This section provides the Methods of Implementation (MOIs) for Power 
Level test using an Agilent 80000 or 90000 Series Infiniium oscilloscope, 
spectrum analyzer, 10GBASE- T Transmitter test fixture and the 
10GBASE- T Electrical Conformance Test Application.

There are two methods of running the Power Level test:

• Using an external spectrum analyzer.

• Using the oscilloscope.
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Connection for Power Level Test Using an External Spectrum Analyzer

When performing the Power Level test, the 10GBASE- T Electrical 
Conformance Test Application will prompt you to make the proper 
connections. The connections for the Power Level test may look similar to 
the following diagram. Refer to the Connection tab in the 10GBASE- T 
Electrical Conformance Test Application for more details.

Test Procedure Using an External Spectrum Analyzer

1 Start the automated test application as described in “Starting the 
10GBASE- T Electrical Conformance Test Application" on page 15.

2 Connect one end of the RJ45 cable to the DUT and another end to J1 
connector on the Section 1 of the 10GBASE- T Transmitter test fixture.

3 Connect the SMP connector pairs, for example A+ and A-  SMP 
connectors to the Balun by using the SMP to SMA cables.

4 Connect the Balun to the spectrum analyzer by using the SMA cable.

Figure 18 Connection for Power Level Test Using an External Spectrum Analyzer



Power Level Test 8

10GBASE-T Electrical Conformance Testing Methods of Implementation 57

 

5 Use a LAN or GPIB to USB cable to connect the spectrum analyzer to 
the oscilloscope. 

6 In the 10G Ethernet test application, click the Set Up tab.

7 Under the Connection group, check the connection pair(s) under test. 
You can select more than one pair of connection.

8 Ensure that the application detects the spectrum analyzer connection to 
the oscilloscope. Else, click on the Connect... button in the Spectrum 
Analyzer External Instruments group. A pop- up box will appear where 
you can enter either the VISA/SICL address or the IP address. Enter 
the information and click the Verify button, followed by the Done 
button to close this box. The VISA/SICL address or the IP address can 
be obtained from the IO Control Connection Expert application, as 
shown in Figure 20.

Figure 19 Setup page and spectrum analyzer pop-up box
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9 Once the application detects the spectrum analyzer, it is indicated on 
the Setup page as shown in Figure 21 below.

Figure 20 Agilent Connection Expert
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10 Enter your comments in the Comments text box.

11 Click the Select Tests tab and check the tests you want to run. Check 
the parent node or group to check all the available tests within the 
group.

Figure 21 Setup page after application has detected the spectrum analyzer
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12 Follow the 10GEthernet test application’s task flow to set up the 
configuration options (see Table 5), run the test, and view the test 
results.

Table 5 Test Configuration Options

Figure 22 Selecting Power Level Test

Configuration Option Description

Connection Pair 
(Positive)

The channel number for connection pair positive.

Connection Pair 
(Negative)

The channel number for connection pair negative.

Power Test

Start Frequency The start frequency for the spectrum analyzer.

Stop Frequency The stop frequency for the spectrum analyzer.

Resolution Bandwidth The resolution bandwidth for the spectrum analyzer.

Test Type The test type for the Power Level test.

Command File The command file for the spectrum analyzer.
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Connection for Power Level Test Using the Oscilloscope

When performing the Power Level  test, the 10GBASE- T Electrical 
Conformance Test Application will prompt you to make proper 
connections. The connections for the Transmitter Power Spectral Density 
test may look similar to the following diagram. Refer to the Connection tab 
in the 10GBASE_T Electrical Conformance Test Application for more 
details.

Test Procedure Using the Oscilloscope

1 Start the automated test application as described in “Starting the 
10GBASE- T Electrical Conformance Test Application" on page 15.

2 Connect one end of the RJ45 cable to the DUT and another end to J1 
connector on the Section 1 of the 10GBASE- T Transmitter test fixture.

3 Connect the SMP connector pairs, for example A+ and A-  SMP 
connectors to the oscilloscope.

4 In the 10G Ethernet test application, click the Set Up tab.

5 Under the Connection group. check the connection pair(s) under test. 
You can select more than one pair of connection.

6 Enter your comments in the Comments text box.

Figure 23 Connection for Power Level Test Using the Oscilloscope
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7 Click the Select Tests tab and check the tests you want to run. Check 
the parent node or group to check all the available tests within the 
group.

8 Follow the 10G Ethernet test application's task flow to set up the 
configuration options (see Table 5), run the test, and view the results.
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Power Level Test - Test Method of Implementation

The purpose of the Power Level test is to verify that the power level of the 
device under test (DUT) meets the specification requirement as specified 
in clause 55.5.3.4 of IEEE 802.3.

For this test, the obtained power level must be between 3.2dBm and 
5.2dBm. This value is verified for each of the four pairs of the 10G test 
mode 5 signaling for a particular DUT. These pairs are identified as Pair 
A, Pair B, Pair C and Pair D.

Test Definition Notes from the Specification

Clause 55.5.3.4 Power Spectral Density

In test mode 5 (normal operation with no power backoff), the transmit 
power shall be in the range 3.2 dBm to 5.2 dBm and the power spectral 
density of the transmitter, measured into a 100 Ω load using the test 
fixture, shall be between the upper and lower masks specified in Equation 
(55- 9) and Equation (55- 10).

Pass Condition

The obtained Power Level must be between 3.2dBm and 5.2dBm from the 
frequency range of 3 MHz to 400 MHz.
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Measurement Algorithm Using an External Spectrum Analyzer

1 Configure the DUT to produce test mode 5 signal.

2 Set the spectrum analyzer as the following:

• Start frequency = 3 MHz, Stop frequency = 400 MHz

• Resolution bandwidth = 3 MHz

• Averaging (default value is 50)

• Band/Interval Power marker function

• DC coupling (not applicable for ESA)

3 Measure the Power Level within range of 3 MHz to 400 MHz.

4 Collect the data from the spectrum analyzer to the application and plot 
the graph.

5 Set the SA to AC coupling mode.

6 Compare the test result with the compliance test limit.

Measurement Algorithm Using the Oscilloscope

1 Configure the DUT to produce test mode 5 signal.

2 Trigger and collect the waveform from the oscilloscope.

3 Apply the selected windowing function to the sampled waveform.

4 Compute the amplitude spectra as:

Where N = number of segments or cycles to compute.

5 Apply a correction factor to the signal to compensate windowing losses:

6 Convert the amplitude to dBm.
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7 Calculate the band power:

Where:

• Bs = specified bandwidth (400 MHz -  3 MHz)

• Bn = equivalent noise bandwidth of frequency resolution

• n1 = index of first point

• n2 = insex of last point

• P = power in Watts

8 Compare the result to the compliance limit.

Test References

See Clause 55.5.3.4 Power Level in the IEEE 802.3- 2006 Standard.

BP Bs Bp⁄( ) 1
n2 n1– 1+
--------------------------- 10

P i[ ] 10⁄
××=



66 10GBASE-T Electrical Conformance Testing Methods of Implementation

8 Power Level Test
 



Agilent Technologies 67

 

U7236A 10GBASE-T Electrical Conformance Test Application
Methods of Implementation

9 
Transmitter Linearity Tests

Connection for Transmitter Linearity Tests    68

Transmitter Linearity Tests - Test Method of Implementation    74

This section provides the Methods of Implementation (MOIs) for 
Transmitter Linearity tests using an Agilent 80000 or 90000 Series 
Infiniium oscilloscope, spectrum analyzer, 10GBASE- T Transmitter test 
fixture and the 10GBASE- T Electrical Conformance Test Application.
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Connection for Transmitter Linearity Tests

When performing the Transmitter Linearity tests, the 10GBASE- T 
Electrical Conformance Test Application will prompt you to make proper 
connections. The connections for the Transmitter Linearity tests may look 
similar to the following diagram. Refer to the Connection tab in the 
10GBASE- T Electrical Conformance Test Application for more details.

Test Procedure

1 Start the automated test application as described in “Starting the 
10GBASE- T Electrical Conformance Test Application" on page 15.

2 Connect one end of the RJ45 cable to the DUT and another end to J1 
connector on the Section 1 of the 10GBASE- T Transmitter test fixture.

3 Connect the SMP connector pairs, for example A+ and A-  SMP 
connectors to the Balun by using the SMP to SMA cables.

4 Connect the Balun to the spectrum analyzer by using the SMA cable.

Figure 24 Connection for Transmitter Linearity Tests
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5 Use a LAN or GPIB to USB cable to connect the spectrum analyzer to 
the oscilloscope. 

6 In the 10G Ethernet test application, click the Set Up tab.

7 Under the Connection group, check the connection pair(s) under test. 
You can select more than one pair of connection.

8 Ensure that the application detects the spectrum analyzer connection to 
the oscilloscope. Else, click on the Connect... button in the Spectrum 
Analyzer External Instruments group. A pop- up box will appear where 
you can enter either the VISA/SICL address or the IP address. Enter 
the information and click the Verify button, followed by the Done 
button to close this box. The VISA/SICL address or the IP address can 
be obtained from the IO Control Connection Expert application, as 
shown in Figure 26.

Figure 25 Setup page and spectrum analyzer pop-up box
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9 Once the application detects the spectrum analyzer, it is indicated on 
the Setup page as shown in Figure 27 below.

Figure 26 Agilent Connection Expert
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10 Enter your comments in the Comments text box.

11 Click the Select Tests tab and check the tests you want to run. Check 
the parent node or group to check all the available tests within the 
group.

Figure 27 Setup page after application has detected the spectrum analyzer
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12 Follow the 10GEthernet test application’s task flow to set up the 
configuration options (see Table 6), run the test, and view the test 
results.

Figure 28 Selecting Transmitter Linearity Tests
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Table 6 Test Configuration Options

Configuration Option Description

Connection Pair 
(Positive)

The channel number for connection pair positive.

Connection Pair 
(Negative)

The channel number for connection pair negative.

Transmitter Linearity 
Tests

Start Frequency The start frequency for the spectrum analyzer.

Stop Frequency The stop frequency for the spectrum analyzer.

Resolution Bandwidth The resolution bandwidth for the spectrum analyzer.

Reference Level The reference level for the spectrum analyzer.

Intermodulation 
Tolerance

The tolerance for intermodulation.

Test Type The test type for Transmitter Linearity tests.

Command File The command file for the spectrum analyzer.
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Transmitter Linearity Tests - Test Method of Implementation

The purpose of the Transmitter Linearity tests is to verify that the device 
under test (DUT) conforms to the Spurious Free Dynamic Range (SFDR) 
requirements specified in clause 55.5.3.2 of IEEE 802.3- 2006.

This SFDR will be verified for each of the four pairs of 10G test mode 4 
with dual tone input signaling for a particular DUT. These pairs are 
identified as Pair A, Pair B, Pair C and Pair D.

Test Definition Notes from the Specification

Clause 55.5.3.2 Transmitter Linearity

When in test mode 4 and observing the spectrum of the differential signal 
output at the MDI using transmitter test fixture 2, for each pair, with no 
intervening cable, the transmitter linearity mask is defined as follows:

The SFDR of the transmitter, with dual tone inputs as specified in test 
mode 4, shall meet the requirement that:

SFDR > 2.5 + min{52,58 -  20 X log10(f/25)} (55- 7)

where f is the maximum frequency of the two test tones in MHz and SFDR 
is the ratio in dB of the minimum RMS value of either input tone to the 
RMS value of the worst inter- modulation product in the frequency range 
of 1 MHz to 400 MHz.

This specification on transmit linearity is derived from the requirement for 
interoperability with the far- end device.

Pass Condition

1 The SFDR of the transmitter for each Lane should meet the below 
requirement:

SFDR > 2.5 + min {52, 58 -  20log10(f/25)}

Where, f = maximum frequency of the two test tones

SFDR = Ratio of the minimum RMS value between two input tone and 
worst intermodulation product of RMS.

2 The test limit of SFDR for each Lane should be different for different 
transmit frequency.
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Table 7 The Test Limit of SFDR

Measurement Algorithm

1 Configure the DUT to produce test mode 4 signal.

1 Set the test frequency.

2 Set the spectrum analyzer as below:

• Start frequency = 1 MHz

• Stop frequency = 400 MHz

• Resolution bandwidth = 300 kHz

• Averaging (default value is 50)

• DC coupling (not applicable for ESA)

3 Collect data from the spectrum analyzer to the application in the 
oscilloscope and plot the graph.

4 Calculate the Intermodulation Product Frequency with the below 
equation:

Even Order = n(A+B), n(A- B) 

where, n = 2,4,6,8,10……120

Odd Order  = N(A) -  (N- 1)(B), N(B) -  (N- 1)(A)

where, N = n -  ((n/2)- 0.5) and n = 3,5,7,9…..119

5 Keep the list of the calculated frequency, L1.

6 Get the peak product frequency from the spectrum analyzer and keep it 
in another list, L2.

7 Compare L1 with L2 and keep the list of the peak value (obtained from 
the spectrum analyzer), L3 with the below condition:

• Frequency values close (with default tolerance of 500 kHz) to the 
frequency in L1.  

8 SFDR = Highest Peak (L3) -  Third highest Peak (L3)

9 Set the spectrum analyzer to AC coupling.

Transmit Frequency Frequency Pair (dBm) Test Limit

1 36.718 & 41.406 > 54.5 dBm

2 78.906 & 80.469 > 50.346 dBm

3 139.844 & 141.406 > 45.449 dBm

4 216.406 & 219.531 > 41.629 dBm

5 310.156 & 313.281 > 38.540 dBm
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10 Compare the test result with the compliance test limit.

Test References

See Clause 55.5.3.2 Transmitter Linearity in the IEEE 802.3- 2006 
Standard.
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U7236A 10GBASE-T Electrical Conformance Test Application
Methods of Implementation

10 
MDI Return Loss Test

Connection for MDI Return Loss Test    78

MDI Return Loss Test - Test Method of Implementation    86

This section provides the Methods of Implementation (MOIs) for MDI 
Return Loss test using an Agilent 80000 or 90000 Series Infiniium 
oscilloscope, vector network analyzer, 10GBASE- T Transmitter test fixture 
and the 10GBASE- T Electrical Conformance Test Application.
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Connection for MDI Return Loss Test

When performing the MDI Return Loss test, the 10GBASE- T Electrical 
Conformance Test Application will prompt you to make proper 
connections. The connections for the MDI Return Loss test may look 
similar to the following diagram. Refer to the Connection tab in 
10GBASE- T Electrical Conformance Test Application for more details.

Test Procedure

1 Start the automated test application as described in “Starting the 
10GBASE- T Electrical Conformance Test Application" on page 15.

2 Connect one end of the RJ45 cable to the DUT and another end to J1 
connector on the Section 1 of the 10GBASE- T Transmitter test fixture.

3 Connect the SMP connector pairs, for example A+ and A-  SMP 
connectors to the Balun by using the SMP to SMA cables.

4 Connect the Balun to the vector network analyzer by using the SMA 
cable.

Figure 29 Connection for MDI Return Loss Test
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5 Use a LAN or GPIB to USB cable to connect the vector network 
analyzer to the oscilloscope. 

6 In the 10G Ethernet test application, click the Set Up tab.

7 Under the Connection group, check the connection pair(s) under test. 
You can select more than one pair of connection.

8 Ensure that the application detects the vector network analyzer 
connection to the oscilloscope. Else, click on the Connect... button in 
the Vector Network Analyzer External Instruments group. A pop- up box 
will appear where you can enter either the VISA/SICL address or the IP 
address. Enter the information and click the Verify button, followed by 
the Done button to close this box. The VISA/SICL address or the IP 
address can be obtained from the IO Control Connection Expert 
application, as shown in Figure 30.

Figure 30 Setup page and vector network analyzer pop-up box
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9 Once the application detects the vector network analyzer, it is indicated 
on the Setup page as shown in Figure 32 below.

Figure 31 Agilent Connection Expert
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10 Instead of connecting to the vector network analyzer, you can also use 
the data file. 

11 To do so, click on the Use Data File and the Edit button will appear, as 
shown in Figure 33. Click on this button to select the data file for each 
pair.

12 A pop- up box will appear where you can browse the data file and 
assign it to each pair under test, as shown in Figure 34. Select the data 
file and click OK.

13 Once the application detects the user file, it is indicated on the Setup 
page as shown in Figure 35 below.

Figure 32 Setup page after application has detected the vector network analyzer
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 Figure 33 Use data file option for vector network analyzer

Figure 34 Data file selection pop-up box
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14 Enter your comments in the Comments text box.

15 Click the Select Tests tab and check the tests you want to run. Check 
the parent node or group to check all the available tests within the 
group.

Figure 35 Setup page after application has detected the data file
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16 Follow the 10GEthernet test application’s task flow to set up the 
configuration options (see Table 8), run the test. 

17 Before running the test, the application will prompt you to calibrate the 
test setup. Connect the other end of RJ45 cable to Section 3 of the test 
fixture to calibrate the test setup. Test setup refers to the setup from 
the RJ45 cable connection point at Section 3 test fixture to the point 
where SMA cables are connected to the connector pairs. 

18 A pop up message box will prompt you to connect the cal fixture to 
OPEN, SHORT, and LOAD port respectively. When this message is 
prompt, connect the mentioned port of Section 3 to another end of the 
RJ45 cable and click OK.

19 Once the calibration is done, the application will continue to run the 
tests.

Figure 36 Selecting MDI Return Loss Test
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Table 8 Test Configuration Options

Configuration Option Description

Connection Pair 
(Positive)

The channel number for connection pair positive.

Connection Pair 
(Negative)

The channel number for connection pair negative.
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MDI Return Loss Test - Test Method of Implementation

The purpose of the MDI Return Loss test is to verify that the MDI return 
loss of the device under test (DUT) meets the specified eye template 
requirement as specified in clause 55.8.2.1 of IEEE 802.3.

MDI Return loss of the DUT is verified for each of the four lanes of the 
test mode 5 signaling for that particular DUT. These pairs are identified as 
Pair A, Pair B, Pair C and Pair D.

Test Definition Notes from the Specification

Section 55.8.2.1 MDI Return Loss

The differential impedance at the MDI for each transmitter/receive channel 
shall be such that any reflection due to differential signals incident upon 
the MDI from a balanced cabling having a nominal differential 
characteristic impedance of 100 Ω is attenuated, relative to the incident 
signal as per the relationship:

where f is in MHz.

Pass Condition

The return loss obtained must be less than 16 dB from 1 MHz to 40 MHz, 
at least 16- 10log10(f/40) from 40 MHz to 400 MHz and at least 
6- 30log10(f/400) from 400 MHz to 500 MHz.

Measurement Algorithm

1 Configure the DUT to produce test mode 5 signal.

2 Calibrate the vector network analyzer with the calibration fixture (load, 
open and short).

3 Set the vector network analyzer as the following:

• Start frequency = 1 MHz and Stop frequency = 500 MHz

• Averaging on.

4 Collect the data from the vector network analyzer to the application 
and plot the graph.

{ 16 1 < f < 40

Return loss > 16- 10log10(f/40) 40 < f < 400 (55- 54)

6- 30log10(f/400) 400 < f < 500
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5 Analyze the collected data by using Matlab and compute the return loss 
for the Zs of 100Ω .

6 Compare the test result with the compliance test limit.

Test References

See Section 55.8.2.1 MDI Return Loss in the IEEE 802.3- 2006 Standard.
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11 
Transmitter Timing Jitter (SLAVE) Test

Connection for Transmitter Timing Jitter (SLAVE) Test    90

Transmitter Timing Jitter (SLAVE) Test - Test Method of 
Implementation    93

This section provides the Methods of Implementation (MOIs) for 
Transmitter Timing Jitter (SLAVE) test using an Agilent 80000 or 90000 
Series Infiniium oscilloscope, 10GBASE- T Transmitter test fixture and the 
10GBASE- T Electrical Conformance Test Application.
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Connection for Transmitter Timing Jitter (SLAVE) Test

When performing the Transmitter Timing Jitter (SLAVE) test, the 
10GBASE- T Electrical Conformance Test Application will prompt you to 
make proper connections. The connections for the Transmitter Timing 
Jitter (SLAVE) test may look similar to the following diagram. Refer to the 
Connection tab in 10GBASE- T Electrical Conformance Test Application for 
more details.

You may connect the SMP to SMA cables to any of the oscilloscope 
channels. You can identify the channels used for each signal in the 
Configuration tab of the 10GBASE- T Electrical Conformance Test 
Application. (The channels shown in Figure 37 is just an example.)

Figure 37 Connection for Transmitter Timing Jitter (SLAVE) Test



Transmitter Timing Jitter (SLAVE) Test 11

10GBASE-T Electrical Conformance Testing Methods of Implementation 91

 

Test Procedure

1 Start the automated test application as described in “Starting the 
10GBASE- T Electrical Conformance Test Application" on page 15.

2 Connect one end of the RJ45 cable to the SLAVE DUT and another end 
to the J2 connector on the Section 2 of the 10GBASE- T Transmitter 
test fixture. 

3 Similarly, connect one end of the RJ45 cable to the MASTER DUT and 
another end to the J3 connector on the Section 2 of the 10GBASE- T 
Transmitter test fixture. 

4 Connect the D+ and D-  SMP connectors to the any two of the 
oscilloscope channels by using the SMP to SMA cables.

5 In the 10G Ethernet test application, click the Set Up tab.

6 Under the Connection group, check the connection pair(s) under test. 
You can select more than one pair of connection.

7 Enter your comments in the Comments text box.

8 Click the Select Tests tab and check the tests you want to run. Check 
the parent node or group to check all the available tests within the 
group.

Figure 38 Selecting Transmitter Timing Jitter (SLAVE) Test
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9 Follow the 10GEthernet test application’s task flow to set up the 
configuration options (see Table 9), run the test, and view the test 
results.

Table 9 Test Configuration Options

Configuration Option Description

Connection Pair 
(Positive)

The channel number for connection pair positive.

Connection Pair 
(Negative)

The channel number for connection pair negative.
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Transmitter Timing Jitter (SLAVE) Test - Test Method of Implementation

The purpose of the Transmitter Timing Jitter (SLAVE) test is to verify that 
the SLAVE transmitter timing jitter of the device under test (DUT) is 
within the conformance limits specified in clause 55.5.3.3 of IEEE 802.3.

For this test, the obtained timing jitter must be less than or equal to 5.5ps 
over a sample size of 200000 + 20000. The jitter value is to be verified for 
Pair D only where the MASTER PHY is set to test mode 1 and SLAVE PHY 
is set in test mode 3.

Test Definition Notes from the Specification

Clause 55.5.3.3 Transmitter Timing Jitter

RMS period jitter over an integration time interval of 1 ms + 10% is 
defined as the root mean square period difference from the average period 
(T -  Tavg) accumulated over a sample size of 200000 + 20000.

Pass Condition

The RMS period jitter measured at the MDI must be less than or equal to 
5.5 ps for all the pairs. 

Measurement Algorithm

1 Configure the SLAVE DUT to produce test mode 3 and the MASTER 
DUT to produce test mode 1 signal.

2 Convert the single ended signal to differential signal: 

FUNC2 = D+ (default Channel1) subtract D-  (default Channel3) to get 
the differential signal.

3 Trigger on the rising edge of D+. Set the trigger level to offset voltage of 
D+.

4 Set the sampling rate to 20 Gsa/s.

5 The number of acquisitions to be taken depends on the time range and 
the memory depth selected by the customers:

Number of Acq = Time Range / (Memory Depth * 1/Sampling Rate)

6 Enable the histogram and measure the period to the acquired 
waveform.

RMS period jitter
T Tavg–( )2[ ]( )

Sample Size
----------------------------------------------=
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7 Take the standard deviation from the histogram statistics.

8 Compare the test result with the compliance test limit.

Test References

See Clause 55.5.3.3 Transmitter Timing Jitter in the IEEE 802.3- 2006 
Standard.
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To Run the Self Calibration    95

Self Calibration    96

This section describes the Agilent 80000 and 90000 Series Infiniium 
oscilloscopes calibration procedures.
To Run the Self Calibration

NOTE Let the Oscilloscope Warm Up Before Adjusting. Warm up the oscilloscope for 30 minutes 
before starting calibration procedure. Failure to allow warm up may result in inaccurate 
calibration.
 

The self calibration uses signals generated in the oscilloscope to calibrate 
channel sensitivity, offsets, and trigger parameters. You should run the self 
calibration

• yearly, or according to your periodic needs,

• when you replace the acquisition assembly or acquisition hybrids,

• when you replace the hard drive or any other assembly,

• when the oscilloscope’s operating temperature (after the 30 minute 
warm- up period) is more than ±5 °C different from that of the last 
calibration.

To calibrate the Infiniium oscilloscope in preparation for running the 
10GBASE- T automated tests, you need the following equipment:

Table 10 Equipment Required

Equipment Critical Specifications Agilent Part 
Number

Adapters (2 supplied with oscilloscope 
except for the DSO90254A)

3.5 mm (f) to precision BNC No 
substitute

Agilent 
54855-67604
95Agilent Technologies
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Cable Assembly 50 W characteristic impedance BNC (m) 
connectors ~ 36 inches (91 cm) to 48 
inches (122 cm) long

Agilent 
8120-1840

Cable Assembly (supplied with 
oscilloscope except for the DSO90254A 
which can use a good quality BNC cable)

No substitute Agilent 
54855-61620

10 MHz Signal Source (required for time 
scale calibration)

Frequency accuracy better than 0.4 ppm Agilent 
53131A with 
Opt. 010

Table 10 Equipment Required

Equipment Critical Specifications Agilent Part 
Number
Self Calibration

NOTE Calibration time: It will take approximately 1 hour to run the self calibration on the 
oscilloscope, including the time required to change cables from channel to channel.
1 Let the Oscilloscope Warm Up Before Running the Self Calibration. 

The self calibration should only be done after the oscilloscope has run 
for 30 minutes at ambient temperature with the cover installed. 
Calibration of an oscilloscope that has not warmed up may result in an 
inaccurate calibration.

2 Pull down the Utilities menu and Select Calibration.

3 Click the check box to clear the Cal Memory Protect condition.

You cannot run self calibration if this box is checked. See Figure 39.
10GBASE-T Electrical Conformance Testing Methods of Implementation
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4 Click Start, then follow the instructions on the screen.

The routine will ask you to do the following things in sequence:

a Decide if you want to perform the Time Scale Calibration. Your 
choices are:

• Standard Calibration -  Time scale calibration will not be performed. 
Time scale calibration factors from the previous time scale 
calibration will be used and the 10 MHz reference signal will not be 
required. The remaining calibration procedure will continue.

• Standard Calibration and Time Scale Calibration -  Performs the time 
scale calibration. This option requires you to connect a 10 MHz 
reference signal to channel 1 that meets the following specifications. 
Failure to use a reference signal that meets this specification will 
result in an inaccurate calibration.

Frequency: 10 MHz ±0.4 ppm = 10 MHz ±4 Hz

Amplitude: 0.2 Vpeak- to- peak to 5.0 Vpeak- to- peak

Wave shape: Sine or Square

Figure 39 Oscilloscope Calibration Window
Clear this check box 
before starting 
calibration
 Conformance Testing Methods of Implementation 97
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• Standard Calibration and Reset Time Scale Calibration -  Factory 
time scale calibration factors will be used. The 10 MHz reference 
signal will not be required. The remaining calibration procedure will 
continue.

b Disconnect everything from all inputs and Aux Out.

c Connect the calibration cable from Aux Out to channel 1.

• You must use the 54855- 61620 cable assembly with two 54855- 67604 
adapters for all oscilloscopes except for the DSO90254A which can 
use a good quality BNC cable. Failure to use the appropriate 
calibration cable will result in an inaccurate calibration.

d Connect the calibration cable from Aux Out to each of the channel 
inputs as requested.

e Connect the 50 Ω BNC cable from the Aux Out to the Aux Trig on 
the front panel of the oscilloscope.

f A Passed/Failed indication is displayed for each calibration section. 
If any section fails, check the calibration cables and run the 
oscilloscope Self Test in the Utilities menu. 

g After the calibration procedure is completed, click Close.
10GBASE-T Electrical Conformance Testing Methods of Implementation
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